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7. DEVELOPMENT OF A TOOL TO MONITOR CROP 
GROWTH AND GRAIN YIELD 

By: Antonio de la Casa1 and Gustavo Ovando2 
 

The Center for Surveying and Assessment of Agriculture and Natural Resources (CREAN) is an applied research 
unit of the Agricultural Sciences Faculty (Department) of the Córdoba National University (Argentina). The general 
objective of CREAN is to contribute to the development of strategies for sustainable management of natural and 
agricultural resources, based on rational use, preservation and recovery of the environmental patrimony. This 
involves the elaboration of application programs using remote sensing information and geographic information 
system. CREAN plays an active role to develop new methodologies to assess desertification processes, crop yield 
productivity and crop geographic distribution. Furthermore the Centre provides technological support to the public 
and private sectors on uses and applications of meteorological and natural resources information. 

7.1. Relevance of the topic selected 

Monitoring of agricultural crops throughout the growing season may provide information to make predictions of 
performance before harvest time. This is important for decision making at various levels, both for logistic and 
commercial activities (Rizzi and Rudorff 2005). 
The yield of a crop is determined by its genetic characteristics and prevailing conditions during the growing period, 
such as climate and weather conditions, soil fertility, pest and disease control, soil water stress and other factors 
affecting crop growth. The crop yield can vary widely in response to dominating conditions. By means of a 
mechanistic crop growth model, the expected yield for several growing conditions can be estimated (Boote et al., 
1998; Brisson et al., 2003; Yang et al., 2004). Such type of models not only simulates yield but also crop development 

throughout the growing cycle. The mechanistic models, however, generally require a huge set of input data which is 
often not readily available outside research stations. Since they also demand an extensive site-specific calibration 
before they can be applied, this type of model might not be very useful for developing irrigation strategies or applied 
to yield forecasting under practical conditions.  
For planning and evaluation purposes with limited data, a more general and simpler approach is available. The 
functional model presented by Doorenbos and Kassam (1979), describing the relation between water stress and the 
corresponding productivity loss is very useful: 

     
       

 
where Ya/Ymax is the relative yield; (1-Ya/Ymax) the relative yield decrease; ETa/ETmax the relative 
evapotranspiration; and (1-ETa/ETmax) the water stress or relative evapotranspiration deficit.  
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The response of yield to water stress for a given environment, is quantified through the yield response factor (Ky). 
The relationship between yield decline and water stress is linear as long as water stress is less than 50%. In the model, 
the actual yield (Ya) is expressed as a fraction of the maximum yield (Ymax) that can be expected under the given 

growing conditions for non-limiting water conditions. ETa refers to the actual crop evapotranspiration under the 
given growing conditions and ETmax is the evapotranspiration under the same conditions but for non-limiting water 
conditions.  
This functional model has been implemented in various ways according to the type and availability of information 
used (Rojas, 2007). Raes et al. (2006) used a water balance procedure to estimated ETa from meteorological 
information (ETmax and precipitation data), as well as soil characteristics relating to soil water content to calculate 
the crop yield loss. 
Remote sensing provides extensive spatial information about the actual status of crops and it has been used to 
support the parameterization of crop models (Guérif and Duke, 2000). The advantages of remote sensing are being 
exploited in recent years to monitor vegetation and assess the impact of drought on crop yield. Caselles et al. (1993) 
used NDVI images from NOAA-AVHRR to determine, together with field data, the various components of the 
FAO Model productivity. Funk and Budde (2009) present a detailed breakdown of the studies on the NDVI and 
crop yield and sustain the desirability of tuning the relationship between drought and productivity on the basis of 
phenological data. De la Casa and Ovando (2007) developed a crop model to estimate the yield of maize at 
regional/departmental level, integrating NDVI data with phenological information. 

A strategy to make yield estimation methods more robust and easily exportable is provided by the integration of 
remote sensing data with crop simulation models (Doraiswamy et al., 2003). Moriondo et al. (2007) present the 
development and testing of a methodological framework which utilizes NDVI data and a simulation model 
(CROPSYST) to estimate the crop phenology. This operation relies on two main steps, the first being the 
computation of above-ground biomass (AGB) obtained through the use of NDVI-derived fraction of absorbed 
photosyntetically active radiation (fAPAR), which is calculated by: 

     
   

 
 
As crop canopy cover fraction (fCov) could be considered similar to fAPAR in corn (Edwards et al., 2005) and 
soybean (Purcell, 2000), this expression can be rewritten as: 
 

 
 
Where εi and PARi are the radiation use efficiency (RUE, g MJ−1) and the photosynthetically active radiation (PAR) 
at day i, respectively; n is the number of simulation days. 
The second step consists of the final partition of the estimated biomass into maximum crop yield (Ymax), which is 
obtained through the use of the harvest index (HI) where HI is set to 0.47 for maize and soybean. 
 

 
The actual evapotranspiration (ETa) can be estimated using different calculation alternatives depending on the 

sources of information. The soil water balance was routinely used, but it needs precipitation (PP) and maximum 
evapotranspiration (ETmax) data, as well as information about the type of soil and its ability to retain water.  
In a similar but more simplified way, NDVI values are considered substitutes to the transpiration rate (Funk and 
Budde, 2009) and therefore the FAO productivity model can be adapted according to the following expression: 
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Where ΣNDVIa is NDVI value accumulated during the entire cycle or each stage of development and ΣNDVImax 
the highest value of all fields. 
Córdoba government compiles statistics of agricultural production using traditional methods based on field surveys 

to establish at department scale the planted/harvested area, yield and production of crops of major economic 
importance (SAyGA, 2010). These methods are laborious, requires field staff and they do not generate results as 
quickly as required by the markets (Rosenthal et al., 1998). 

7.2. Objective of the application 

This application proposes to develop a semi-operational procedure to estimate corn and soybean yield in Cordoba 
Province, Argentina. The procedure will be implemented in a regional framework making use of different ILWIS 
routines to calculate FAO Model productivity components, with NDVI data from MODIS satellite, and local (in 
situ) field information.  

7.3. Data collection and pre-processing 

7.3.1. NDVI data 

Ensure that you have unzipped the exercise data and move using the ILWIS navigator to this active working 
directory. Once close ILWIS and Open ILWIS again to ensure that the directory settings are correct. You can have a 
look at the data that is available in this folder; open the map list “sub_modis_ndvi” and display the map list as an 
animated sequence, using as Representation “NDVI1”. For this application 17 raster NDVI images (MODIS - 
MOD13Q1 16 days product, 250m, tile h12v12, ENVI format), ranging from September 2005 to May 2006 have 
been selected. These images were transformed to ILWIS image format and a sub map was prepared covering the 
region of interest. Further details are listed in table 7.1.  
 

Raster Name From To SRAD 
sub_modis_ndvi_1.mpr 6-Sep-05 21-Sep-05 11.6 
sub_modis_ndvi _2.mpr 22-Sep-05 7-Oct-05 16.8 
sub_modis_ndvi _3.mpr 8-Oct-05 23-Oct-05 18.2 
sub_modis_ndvi _4.mpr 24-Oct-05 8-Nov-05 19.8 
sub_modis_ndvi _5.mpr 9-Nov-05 24-Nov-05 20.7 
sub_modis_ndvi _6.mpr 25-Nov-05 10-Dec-05 21.6 
sub_modis_ndvi _7.mpr 11-Dec-05 26-Dec-05 20.5 
sub_modis_ndvi _8.mpr 27-Dec-05 11-Jan-06 23.1 
sub_modis_ndvi _9.mpr 9-Jan-06 24-Jan-06 23.3 
sub_modis_ndvi _10.mpr 25-Jan-06 9-Feb-06 19.0 
sub_modis_ndvi _11.mpr 10-Feb-06 25-Feb-06 19.6 
sub_modis_ndvi _12.mpr 26-Feb-06 13-Mar-06 22.2 
sub_modis_ndvi _13.mpr 14-Mar-06 29-Mar-06 18.2 
sub_modis_ndvi _14.mpr 30-Mar-06 14-Apr-06 17.6 
sub_modis_ndvi _15.mpr 15-Apr-06 30-Apr-06 13.8 
sub_modis_ndvi _16.mpr 1-May-06 16-May-06 15.8 
sub_modis_ndvi _17.mpr 17-May-06 1-Jun-06 14.1 

Table 7.1 NDVI images, timing details and Manfredi accumulated solar radiation (SRAD, MJ m-2) 

7.3.2. Administrative boundary map 

The administrative boundaries have been obtained from a vector map with departmental boundaries of Cordoba 
Province, in drawing exchange format (DXF), imported in ILWIS and have been named “boundary”. Add the 
polygon file “boundary” to your active map display window, using “info off” and “boundaries only” Display 
Options. 
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7.3.3. Meteorological data 

The daily solar radiation data from Manfredi meteorological station (31° 49’ 12’’ S, 63° 46’ 00’’ W, altitude 292 m osl) 
have been used, located in the central area of Cordoba. The accumulated value for each image period was calculated 
(see table 7.1).  

7.3.4. Canopy cover fraction (fCov) measurements 

Field measurements of fCov were made by classification of digital photos with a maximum likelihood algorithm, as is 
shown in figure 7.1. Pictures for soybean and corn crops were collected during 3 years, including the 2005-2006 crop 
cycle, in several fields in the central region of Cordoba. They were taken vertically from a height of 1.5 m. In total 
150 pictures have been classified for soybeans and corn.  

Figure 7.1 fCover measurements of corn, original (left) and classified results (right) 
 
The fCov values were analyzed by regression with NDVI to obtain a model which was used for both crops. The 
model used is:  
 

7.3.5. Departmental Crop yield data  

The Agricultural Secretary of Córdoba Province supplies statistics of departmental agricultural production. They use 
traditional methods based on reports to establish the planting, harvesting, yield and production of crops of major 
economic importance in the region (SAyGA, 2010). Details are provided in Table 7.2. 
 

ID 

Number 
Department 

Corn Yield 

(kg ha-1) 

Soybean Yield 

(kg ha-1) 

1 Calamuchita 7,000 2,442 

2 General Roca 6,800 2,300 

3 Gral. San Martín 5,500 2,150 

4 Juárez Celman 6,000 2,370 

5 Marcos Juárez 8,000 3,300 

6 Pte. R. S. Peña 6,500 2,200 

7 Río Cuarto 4,000 2,000 

8 Río Primero 6,000 2,200 

9 Río Segundo 7,000 2,300 

10 San Justo 5,500 2,050 

11 Santa María 6,500 2,400 

12 Tercero Arriba 6,500 2,800 

13 Unión 7,000 2,442 

 
Table 7.2 Corn and soybean yields of main agricultural crops in Cordoba in 2005-2006 crop season 

245,0228,1  NDVIfCov Eq. 7 



APPLICATION MANUAL 

87 

7.4. Methodology 

The flow chart showing the procedure adopted to estimate grain yield is presented below in figure 7.2.  

Figure 7.2 Flow chart of adopted methodology 

7.5. Data processing and analysis 
The various data processing steps, as indicated in figure 7.2 are further elaborated upon below. 

7.5.1. NDVI images (step ❶) 

Once more display one of the 17 NDVI images, open the map list “sub_modis_ndvi” and display as example the 
first date image “sub_modis_ndvi _1” using as Representation “NDVI1”. Note that most of the necessary pre-
processing has already been done, this mainly in order to limit the file size needed to conduct the exercise. Check the 
map values by pressing the left mouse button and roaming the mouse over the active map window. Note the time 

steps of each of the NDVI images as is given in table 7.1. Add to your active map window the polygon file 
“boundary”, use the display option “Boundaries Only”. From the Menu of your active Map Window, select “File => 
Open Pixel Information”. Check the content from the pixel information window; note that the departmental crop 
yield data have been added, identical to table 7.2. Move with the cursor over the northernmost Department, called 
San Justo and note the negative NDVI values over the water body. These negative NDVI values do not represent 
vegetation and therefore these will be reclassified as “no data” values”. Close all active map windows.  Now from the 
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Figure 7.4 NDVI profiles 

main ILWIS window, select the options “Operations => Raster Operations => Maplist Calculation”. Fill the 
MapList Calculation window as given in figure 7.3 and press “Show” to execute the operation. Display the resulting 
maplist “sub_modis_ndvi_und” as an animated sequence and check the values, note that no data is represented by a 

“?”. 

Figure 7.3 Reclassify negative NDVI values as no data values  

7.5.2. Solar radiation (step ❷) 

The solar radiation values used are provided in table 7.1 (see column SRAD) and is further described under the 
section “Meteorological data” in chapter 7.3.3.  

7.5.3. Crop classification (step ❸) 

To evaluate different crops existence a multi criteria classification method 
was adopted based on the knowledge of corn and soybean growing cycles 
in Cordoba province as reflected by the NDVI profiles, see also figure 7.4. 
Soybean is cultivated in 2 different ways: late soybean (soybean_2) is sown 
after wheat so it is expected that the September NDVI values are high, they 
are lowest at harvest time in December, and rising to a maximum in 
February when soybean full cover occurs. Following this criteria a Boolean 
raster map can be calculated by typing the following expression in the 
command line of the main ILWIS menu:  
 

soybean_2:=iff((sub_modis_ndvi_und_1>0.6)and(sub_modis_ 
ndvi_und_7<0.3) and(sub_modis_ndvi_und_11>0.7),1,0) 

 
Press enter to execute the operation and after the calculation has finished 
display the map. On the other hand, as early soybean (soybean_1) comes 
from fallow therefore the September NDVI is low, the sowing starts in 
November so the maximum NDVI appears in late December. To separate 
this crop we use the following expression:  

soybean_1:=iff((sub_modis_ndvi_und_1<0.3)and(sub_modis_nd
vi_und_8>0.7)and(sub_modis_ndvi_und_12>0.5)and(sub_modis 
_ndvi_und_15<0.3),1,0) 

 
For corn, similar to early soybean, the minimum value occurs in September, but as thermal requirements are lower 
than soybean, the seeding can be earlier so it’s maximum NDVI value is reached in November (corn_1) or 
December (corn_2). The expressions used for the classification of corn are:  
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corn_1:=iff((sub_modis_ndvi_und_1<0.3)and(sub_modis_ndvi_und_6>0.6)and(sub_modis_ndvi_und_15
<0.3),1,0) 
 

corn_2:=iff((sub_modis_ndvi_und_1<0.3)and(sub_modis_ndvi_und_7>0.7)and(sub_modis_ndvi_und_12
<0.5)and(sub_modis_ndvi_und_15<0.3),1,0) 

 
Execute the expressions from the command line of the main ILWIS menu, display and check your results. For the 
exercise we only need to know where soybean and corn are cropped because they have different radiation use 
efficiency values (ε), so we make a unique Boolean image for each crop using the following commands:  
 

soybean:=iff((soybean_1=1)or(soybean_2=1),1,0) 
corn:=iff((corn_1=1)or(corn_2=1),2,0) 
 

To check the results of the classification, basically to see if crops are double classified, add the soybean and the corn 
maps together, using the following expression from the command line of the main ILWIS menu: 
 
 class_check:=corn+soybean 
 

display the map using as Representation “lai_SAF” and visually check your results, note the values range from 0 to 3, 
as corn has been assigned a value of 2! Close the map and right click the mouse button over the map “class_check”, 
from the context sensitive menu, select the option “Statistics => Histogram” and press “Show” to see the statistics 
per class. To correct for the classification error, execute the following expression from the command line of the main 
ILWIS menu: 
 
 class_cor:=iff(class_check<3,class_check,0) 
 
display the map using as Representation “lai_SAF” and visually check your results, note the values range now from 0 
to 2, soybean is now classified with a value of 1 and corn has obtained a value of 2. 
Finally the distribution of the classified pixels per department has to be considered. Right click the mouse button 
over the polygon map “boundary”, from the context sensitive menu, select the option “Polygon to Raster”, as 
Output Raster Map, leave “boundary”, use as Georeference “sub_modis_ndvi_1” and press “Show”. Note that the 
map is resampled to the NDVI georeference, which is in the original MODIS projection, the so-called Sinusoidal 
Projection, therefore the boundaries look distorted. Next step is to cross the raster map “boundary” with the map 
“class_cor”, select from the main ILWIS menu the option “Operations => Raster Operations => Cross” , as 1st 
Map specify “boundary” and as 2nd map select “class_cor”, as Output Table specify “representation_department” 
and press “Show”. Check the results shown in the displayed cross table, type the following expressions in the table 
command line: 
 
 pixel_soybean:=iff(class_cor=1,npix,?) 

 pixel_corn:=iff(class_cor=2,npix,?) 
 
New columns are created showing the number of pixels representing corn and soybean per department. These two 
newly created columns are going to be added to the attribute table “boundary”. Close the table 
“representation_department” and open the table “boundary”. From the active table menu, select the option 
“Column => Join”, as table select “representation_department” and as Column “pixel_soybean”, press “Next” 4 
times, accept the default Output Column “pixel_soybean” and press “Finish” and “OK”. Repeat this procedure to 
join also the “pixel_corn” column. Your results should represent those as provided in figure 7.5 
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Figure 7.5 Yield and number of sample pixels per Department for corn and soybean 

7.5.4. Sum of NDVI (step ❹) 

To calculate the sum of NDVI from all images during the crop cycle (from band 7 to 14) use the Maplist Statistics 
utility to obtain the ndvi_sum. From the main ILWIS window, select the options “Operations => Statistics => 
MapList =>Maplist Statistics”. Fill the MapList Statistics window as given in figure 7.6 and press “Show” to execute 
the operation.  

Figure 7.6 MapList Sum Function 
 
Display the resulting “ndvi_sum” map using as Representation “lai” and note the minimum and maximum values of 
the map. Move the mouse with the left mouse cursor pressed over the active map window. 

7.5.5. fCov*PAR calculation (steps ❺ and ❻) 

For each of the NDVI maps during the crop cycle (from band 7 to 14), the fCov needs to be calculated, in this case 

using equation 7 (see chapter 7.3.4). This can be combined with the average of the solar radiation transformed to 
PAR (PAR=SRAD*0.5) for a 16 days period (see table 7.1). Type the following expression in the command line of 
the main ILWIS menu: 
 

fCov_PAR7:=(sub_modis_ndvi_und_7*1.228-0.245)*10.25*16 
 
use the default values and press “OK”. For first date, where the solar radiation was 20.5, the PAR is 10.25 Mj m-2 d-
1. Display the resulting map and check the values obtained, use as Representation “Pseudo”. Repeat this procedure 
for the other maps for the crop cycle using the expressions below (note the changing PAR values): 
 

fCov_PAR8:=(sub_modis_ndvi_und_8*1.228-0.245)*11.55*16 
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fCov_PAR9:=(sub_modis_ndvi_und_9*1.228-0.245)*11.65*16 
fCov_PAR10:=(sub_modis_ndvi_und_10*1.228-0.245)*9.5*16 
fCov_PAR11:=(sub_modis_ndvi_und_11*1.228-0.245)*9.8*16 

fCov_PAR12:=(sub_modis_ndvi_und_12*1.228-0.245)*11.1*16 
fCov_PAR13:=(sub_modis_ndvi_und_13*1.228-0.245)*9.1*16 
fCov_PAR14:=(sub_modis_ndvi_und_14*1.228-0.245)*8.8*16 

 
For all resulting fCov_PAR* maps a new MapList has to be created, from the main ILWIS menu, select “File => 
Create => MapList”, specify as Map list name “fCov_Par” and add the maps in a sequential order using the “>” 
sign. See also figure 7.7. 

Figure 7.7 Final Maplist of fCov_PAR 

7.5.6. Maximum yield – Ymax (step ❼) 

As shown in the flowchart (see figure 7.2), Ymax is calculated using the sum of fCov_PAR, multiplied by the 
Radiation Use Efficiency (ε) and the Harvest Index (HI). To calculate fCov_PAR_sum, use the Maplist Statistics 
option. From the main ILWIS menu, select the options “Operations => Statistics => MapList =>Maplist 

Statistics”. Fill the MapList Statistics window as given in figure 7.8 and press “Show” to execute the operation.  

Figure 7.8 MapList Statistics SUM function of fCov_PAR 
 
As there are negative values, this intermediate map is corrected and all negative values are re-assigned as undefined 
(?). Type the following expression on the command line in the main ILWIS menu: 
 

fCov_PAR_sum_cor:=iff(fCov_Par_sum ge 0,fCov_Par_sum,?) 

 
Use the settings as given in figure 7.9 for the “Raster Map Definition” and press “OK” to execute the operation. 
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 Figure 7.9 Raster Map Definitions 
 
To estimate maximum yield (Ymax) for each crop one has to take into account different ε values (1.8 gr Mj-1 and 3.8 
gr Mj-1 for soybean and corn, respectively (Sinclair and Mochow, 1999; Lindquist et al., 2005). For both crops a 
harvest index (HI) of 0.47 is assumed. To obtain the estimated yield in kg ha-1 furthermore a conversion factor of 10 
needs to be applied. These two computations can be done using a single expression from the command line in the 
main ILWIS menu: 
 

Ymax_soybean:=iff(class_cor=1,fCov_Par_sum_cor*1.8*0.47*10,?) 
Ymax_corn:=iff(class_cor=2,fCov_Par_sum_cor*3.8*0.47*10,?) 
 

Execute both expressions and check the resulting maps. 

7.5.7. Actual yield - Ya (Step ❽) 

From experimental data the accumulated NDVImax value obtained from of a set of 10 plots within the study area 
was 7.6 for the entirely cycle. To account for different crop water stress sensibility a Ky value of 2.1 and 1.3 for 
soybean and corn is applied, respectively. The ILWIS commands to calculate the actual yield are shown below: 
 

Ya_soybean:=iff(class_cor=1,Ymax_soybean-Ymax_soybean*2.1*(1-ndvi_sum/7.6),?) 

Ya_corn:=iff(class_cor=2,Ymax_corn-Ymax_corn*1.3*(1-ndvi_sum/7.6),?) 
 
Execute the expressions and display the resulting maps, check the values obtained. 

7.5.8.  Image Masking (step ❾) 

Display the map “Ya_soybean” and add to this map the polygon map “boundary” using the Display Options Info 
off and Boundaries Only. Repeat this procedure once more using the map “Ya_corn” and check the distribution of 
those pixels that have been used to calculate the yield of corn and soybean respectively. Also use the option “Pixel 
Information”, select “File => Pixel Information” from the active map display window. Close all active map 
windows. 

7.5.9. Yield per Department (Step ❿) 

In order to obtain the average Yield per Department the yield of each crop of every agricultural administrative region 
has to be extracted and aggregated to obtain the average yield. To do so select from the main ILWIS in menu the 
options “Operations => Raster Operations => Cross”, as 1st Map select “boundary” and as 2nd map “Ya_corn”. As 
Output Table specify “department_corn” and press “Show” to execute the operation. Open the table 
“department_corn” and note the content of the table. From the table menu, select the option “Columns => 
Aggregation” and specify the Aggregate Column Options window as indicated in figure 7.10 (left) and press “OK”. 
Note that the average yield for corn is computed per department and the result is added to the table “boundary”, 
using a new column, named “Ya_corn”. Close the cross table. 
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Repeat the Cross operation, now using as 1st Map “boundary” and as 2nd map “Ya_soybean”. As Output Table 
specify “department_soybean” and press “Show” to execute the operation. Again note the content of the table 
created. Again use the aggregation function as given in figure 7.10 (right), now use the column “Ya_soybean”, as 

output table specify “boundary” and as output column “Ya_soybean” 
 

Figure 7.10 Table Aggregation of corn – soybean yield per Department 
 
Now open the table “boundary” and inspect the newly created columns called “Ya_corn” and “Ya_soybean”. Also 
have a look at figure 7.11. From the table menu, select the options “Columns => Statistics”, select as function 
“Correlation” and calculate the correlation between the columns “CornYield” – “Ya_corn” and between the 
columns “SoybeanYield” – “Ya_soybean”. 

Figure 7.11 Resulting table showing observed versus calculated yield 
Calculate the residuals as well. Type from the table command line the following equations and press “OK” to 
execute these: 
 Res_corn:=cornyield-ya_corn 
 Res_soybean:=soybeanyield-ya_soybean 
 
From the Table menu, select the “Graph” icon, in the “Create Graph” menu, unselect the “X-Axis” and select for 
the “Y-axis” the column “Res_corn” and press “OK”. From the left hand graph legend, double click the 
item ”Res_corn” and change the representation to “Line”. From the Graph Menu, select “Edit => Add Graph => 
From Columns” and select the column “Res_soybean” and press “OK”. Again double click on the “Res_soybean” 
item in the graph legend and change it to a line representation, eventually change the colour. Double click on the 
graph title and change the name, repeat this also for the Y-Axis description. Your results should resemble those of 

figure 7.12. 
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 Figure 7.12 Residual analysis of the observed versus calculated yields 
  

7.6. Conclusions 

This exercise shows a methodology that was developed using a geographic information system for estimating corn 
and soybean yields for the province of Cordoba, Argentina, applying only NDVI data (derived from MODIS, having 
a pixel size of 250 m) and solar radiation as background information. 
This procedure is a first prototype that, despite its simplified design, produces objective results which are in contrast 
with the qualitative survey method currently used by the state agency. It should be noted that in general far fewer 
pixels have been used to calculate the average yield for corn, for the Department Calamuchita only 13 pixels have 
been used. This might explain the high residual obtained but in general further validation of the approach is required. 
The FAO method for estimating crop productivity structured in a geographic information system is flexible to 
incorporate calculation routines in a modular format. According to the information available the estimation of Ymax, 
ETmax and Eta can be changed using methodologies which are more accurate but often more complex. 
Improving the procedure at a later stage should take into account also the different sensitivity to water stress of 
crops at different phenological stages, as well as the use of spatially distributed rainfall data using satellite derived 

rainfall estimates. 
Furthermore the MODIS derived NDVI could be replaced by the MSG (SEVIRI-Instrument) derived NDVI which 
is has currently become available. 
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